Stars and

Constellations: The Big
Dipper—Guide to the Sky

Stars are scattered across the nighttime sky in a way that can be
bewildering to a person who is unfamiliar with the patterns that are
formed. However, the sky is like any unfamiliar location—once you
are able to recognize a few prominent landmarks, you can begin to
find your way around with relative ease, and filling in the areas
between the landmarks can be quite enjoyable. The landmarks in the
sky are the brightest stars and the constellations.

This exercise is designed to familiarize you with several of the major
constellations and bright stars that can be seen from mid-northern
latitudes on the Earth. Once you know these patterns and can find
them in the nighttime sky, you can use them as landmarks or direc-
tion finders to locate other stars and constellations and, with practice,
you can become an expert at finding your way around the sky.

In history, the constellations were groups of stars, which outlined in
crude, formed a familiar object or pattern. In modern astronomy, the
constellations are 88 “officially designated” areas of sky, covering the
entire celestial sphere with no gaps between them (Section 2-2 of
Kaufmann & Freedman, Universe, Fifth Ed). However, most people,
including most astronomers, think of a constellation more often in
terms of the historical star pattern than as a set of invisible boundary
lines dividing the sky into sections.
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There are other patterns of stars called “asterisms,”” which are useful
to know, even though they are not constellations. Some of these aster-
isms are part of a larger constellation; for example, the Big Dipper is
part of the constellation Ursa Major, or the Big Bear. Other asterisms,
such as the Summer Triangle (Figure 2-8, Universe), extend over sev-
eral constellations.

It is important to note that, at any given time of the night, not all of
the stars and constellations described in this exercise will be visible.
You should be able to find some of them, but others will be below the
horizon and therefore hidden from view. To see these constellations,
you need to try again at a different time of night (e.g., before dawn)
or at a different time of the year. The changing appearance of the
night sky is described in Section 2-3 of Universe.

Since the purpose of this exercise is for you to become familiar with
the nighttime sky, we will first set up the screen to show only stars
and constellations, eliminating distractions such as the horizon and
daylight, and the Sun, Moon and planets. We will also select a mid-
northern latitude on the Earth—New York City, at about 40° north
latitude—to allow a clear view of the parts of the sky in which we are
most interested, and we will begin by facing north. This flexibility is
possible through the magic of a computer!

In this exercise, Part 1 leads you through the steps needed to set up
the screen, and Part 2 then guides you to the stars and constellations
that can be found by using stars in the Big Dipper as pointers. Some
of these alignments are also described in Section 2-3 and Figure 2-6
of Universe.

Starting the Program

Start the program by clicking the mouse on the “Starry Night™,
Freeman Edition” icon on the “Windows™ screen or by running the
“Starry Night™ Freeman Edition” program from the location where
it was initially installed (e.g., C:\Program Files\Sienna\Starry Night™
Freeman Edition\).

The initial set-up of this program is for the “present” time (i.e., Now)
at the default location, which is most likely your present location.
Each of these parameters can easily be adjusted at any time.



The default function for the mouse is the Grabber Tool, whose mouse
icon is a hand. The Grabber Tool can be used to change the observer’s
viewing direction by clicking and holding the left mouse button while
the icon is “dragged” anywhere on the screen. To activate the Grabber
Tool if it is not already activated, first click Window in the menu bar
and look to see if the menu says “Show Floating Palettes” or “Hide
Floating Palettes.” Click on ““Show Floating Palettes™ if this is what
the menu says, and you should see the icon/location box appear on the
screen. You can recognize this box by the four icon buttons in a square
at the top of the box. One of these four icons should be the Grabber
Tool, which can be activated by clicking on this button. (If the
Window menu says “Hide Floating Palettes,” then the icon/location
box should already be visible on the screen.) Alternatively, you can
activate the Grabber Tool by pressing the F4 key.

The Grabber Tool is one of four tools that can be used for various
purposes within the program. The other screen tools can be activated
by clicking on the appropriate icon in the icon/location box or by
using the correct F key. They each have a different mouse icon. The
Object Selection Tool (click on the arrow icon or press F3) can be
used to identify any object on the screen by pointing the arrow icon
at the object in question and clicking the left mouse button. The third
tool, the Constellation Selection Tool (click on the line-shape-and-
arrow icon or press F5), can be used to identify the constellation in
which the mouse icon has been placed. The fourth tool, the
Magnification Tool (click on the magnifying glass icon or press F8),
can be used to zoom in on a particular region of the sky around the
mouse position, the extent of the region being shown by its width in
degrees in the box at the bottom of the icon/location box. The mag-
nification can be reversed by clicking the left mouse button while
holding down the Control (CTRL) key. The screen icon will change
to a minus sign at this time to indicate this “zoom-out™ function.

PART 1: Screen Set-up

1. Switch off daylight. You can do this by clicking on Daylight in
the Display menu. Or, instead, you can simply press CTRL+D;
that is, holding down the CTRL key while you press D.

2. Similarly, switch off the horizon either by clicking on Horizon
in the Display menu or by pressing CTRL+H.
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3. Switch off the planets by clicking on Planets in the Display menu.

4. Set your location to New York. You can do this by following
these steps:

a. Click on Viewing Location in the Settings menu. A new
screen should appear, displaying a map of the world and a
list of continents.

b. Click on the small triangle next to the words “North
America’ in the list of continents, then click on the tri-
angle next to the words “United States.” A list of U.S.
cities should appear.

C. Go to the lower-right-hand corner of the list of cities,
and click the down arrow (little black triangle) several
times until you can see New York in the list of cities.
Click on New York to highlight it.

d. Click on the Set Location button, which is located to
the lower right of the world map.

5. Set the date to 1/01/1999 AD using the following steps:

a. Go to the Window menu and look to see if Time has
a check mark beside it. If it does not, then click Time
to activate the date/time box. If there is already a
check mark there, then this box should already be
activated. You can recognize the date/time box by
the button in it, which says “Now.” (Alternatively,
you can activate the date/time box by pressing
CTRL+T.)

b. There is a row of buttons in the date/time box, one of
which has a black square on it. This is the time-stop
button. If this button is not already highlighted, then
click on it to stop the progress of time.

C. Today’s date is shown in date/time box in the form
MONTH/DAY/YEAR AD (e.g., 10/23/1998 AD).
Change the date to 1/01/1999 AD. To do this, click on
the number corresponding to the MONTH, then type
the number 1 (e.qg., if the date is 10/23/1998 then click
on the 10 and type 1). This will replace the 10 with
the number 01. Next, click on the DAY (e.g., 23) and
type 1; and finally click on the YEAR (e.g., 1998), and
type 1999.

6. Directly below the date in the date/time box, you should see



the time in the form HOURS:MINUTES:SECONDS, followed
by AM or PM. Change the time to 12:30:00 PM, just after
midday. You can do this the same way that you changed the
date in step 5b, above. If the time shown is AM, do not forget
to change it to PM (click on AM, then type P).

Look near the bottom of the icon/location box and check that
the Viewing Elevation is 3 m. If the elevation is any other num-
ber of meters, click on the button with the little house on it in
this box. The buttons with the rising and falling rockets on them
can be used to increase or decrease your elevation; clicking on
the house button gets you back to the default value of 3 m.

Look again near the bottom of the icon/location box and
check that the Field of View is 100°. The plus and minus sym-
bols inside little magnifying glasses can be used to change the
field of view, while the third button in the same row resets the
field of view to the default value of 100°.

Finally, change your viewing location to North. To do this, go
to the Window menu and see if Toolbar has a check mark
beside it. If it does not, then click on Toolbar. You should now
see a row of buttons on the screen, four of which should say
N, S, E, and W. Click once on the N button, and you should
see the stars move across the screen until you are facing
directly north.

If you are familiar with the Big Dipper, you should now see it
near the upper-left-hand corner of the screen.

PART 2: Using the Big Dipper
as a Guide to the Sky

1.

Find the Big Dipper. This asterism, part of the constellation
Ursa Major, or the Big Bear, consists of seven moderately
bright stars that form the shape of a dipper that you might use
to scoop water out of a bucket. It should be on the left-hand
or upper-left-hand side of the screen. The bowl of the Big
Dipper consists of four stars forming a slightly skewed rectan-
gle, and the handle consists of three stars forming an arc
extending toward the left (or upper left) in the orientation on
your screen. In the actual sky the Big Dipper can have any ori-
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entation, such as upside down or hanging downward from its
handle, depending on the time of night and the time of year.
This is because these stars, and indeed all stars, appear to
rotate around the North Pole position in our sky.

You can check that you have found the correct pattern of stars
by clicking Constellations in the Guides menu to display a set
of connecting lines that outline the patterns of stars. You might
be able to make out the shape of a bear in this, the constella-
tion Ursa Major or the Big Bear! At any rate, you will see this
name identifying the group of stars near the upper-left-hand
corner of the screen. Click Guides/Constellations a second
time to switch the constellations off again; leaving the lines on
will create confusion. Since the real sky has no lines in it, it is
important to become familiar with finding your way around
the sky using only the stars.

The Big Dipper is one of the most important constellations to
know in the sky because the stars in it can be used as pointers
to find many other stars and constellations, particularly the
North Pole Star.

We will need to define two words: “upward” and “down-
ward,” relative to the Big Dipper. First tilt your head, or imag-
ine that you have tilted your head, so that the dipper is hori-
zontal with the handle to your left and the bowl opening
upward. This defines “upward” relative to the Big Dipper.
“Downward” is the opposite direction—the direction in which
water would drip if the bowl leaked. For example, if in the real
sky the Big Dipper is standing vertically on its handle (bowl
above the handle), then upward from the bowl would be
toward the left in the sky, and downward from the bowl
would be toward the right.

Now use the Big Dipper to find the North Star, Polaris. To do
this, first find the two stars that are on the end of the bowl far-
thest from the handle. These are often called the “pointer stars.”
Start from the bottom star (the star at the bottom of the bowl
farthest from the handle), and extend an imaginary straight line
upward through the top star (at the top of the bowl). If you con-
tinue to extend this line upward a total distance approximately
equal to 5 times the spacing of these pointer stars, you should



find a moderately bright star. This is Polaris, the North Star.
(The North Star is not a really bright star—it is actually slightly
fainter than the brightest stars in the Big Dipper—but it is the
brightest star in that little patch of sky.)

If you have found the correct star, then you should see a line
of four stars on the screen, curving away from Polaris in an arc
toward the handle of the Big Dipper. The first three of these
stars are fainter than Polaris and the fourth is about equal in
brightness to Polaris. These stars are part of the Little Dipper,
which consists of the brightest stars in the constellation Ursa
Minor, or the Little Bear.

Click on Guides/Constellations to bring up the constellation
lines and names, and check that you have found Ursa Minor
correctly; then click the constellation lines off again.

Notice that the two stars in the bowl of the Little Dipper fur-
thest from the North Star (i.e., closest to the Big Dipper’s han-
dle) are brighter than all the other stars in the Little Dipper
except Polaris. These two stars are often called the
“Guardians” because, as the sky turns, they always remain
between the Big Dipper and Polaris and “guard” Polaris from
the Big Dipper (or from the Great Bear). In a city, with its light
pollution, you might find when you look at the real sky that
the only stars of the Little Dipper that you can see are Polaris
and the two Guardians.

In clicking the constellation lines on and off again, you may
find that one of the four stars in the bowl of the Little Dipper
is ““missing.”” It is visible in the real sky if the sky is very dark,
with no bright moonlight, city lights, or other light pollution. If
it is missing from your screen, this is caused by its being fainter
than the lowest brightness limit of the stars in the program.

The brightness, or “magnitude,” of the stars that appear in the
sky view in this program can easily be changed to match the
expected sky conditions at any site. To do this, simply click on
Magnitudes in the Settings menu. A slider control can be
adjusted with the mouse to change the star brightness. A par-
ticular setting can be tried by using the Apply command.
Clicking on OK will then return you to the screen. The stars
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shown in this program are limited to a sub-set of the stars in
the real sky, those that are brighter than a certain limit. Thus,
using this “brightness™ facility will merely brighten or darken
those that are visible but will not bring fainter stars into view.

With the constellation lines turned off, check again that you
can find the pointer stars in the Big Dipper and that you can
use them to find Polaris. Then check that you can see the Little
Dipper, with its two Guardian stars, hanging downward in an
arc toward the handle of the Big Dipper.

Now, with the constellation lines clicked off, locate the con-
stellation Cassiopeia (the Queen of Ethiopia). To do this, start
at the handle of the Big Dipper and imagine a straight line
drawn from this position through the North Star to approxi-
mately an equal distance beyond it. The end of this line should
place you in a group of stars shaped like a W. In the orientation
on your screen at this time, the right side of the W should be
tilted upward. (At other times and in other orientations, it may
look more like an M, depending on which side is facing down.)

Click the constellation lines on to check that you have found
Cassiopeia correctly, then click them off again.

If you look carefully, you may see a faint band of brighter sky
on your screen, running downward through Cassiopeia. This
band of light depicts the Milky Way, made up in the real sky
of countless faint stars. Most of these stars are too faint to be
seen individually with the unaided eye, but their collective
light contributes to a faint glow in the sky.

With the constellation lines clicked off, check again that you can
find Cassiopeia using the handle of the Big Dipper and Polaris.

Now find the star Capella. To do this, first find the two stars
on the top of the bowl of the Big Dipper. One of these two
stars marks the point where the handle joins the bowl, and the
other is across the top of the bowl from the first star.

Draw an imaginary straight line through these two stars, start-
ing where the handle joins the bowl, and extend it a long way
across the sky (toward the lower right of your screen). The
first really bright star that you come to is Capella, in the con-



stellation Auriga, the Charioteer. (When you look at Capella in
the real sky, you may notice that it has a slightly yellowish tint
because it is roughly the same temperature as the Sun.
However, our Sun is a dwarf star and Capella is a supergiant,
so they are very different from each other in size.)

Click the constellation lines on again to check that you have
found the constellation Auriga correctly, then click them off
again. Capella is the brightest star in Auriga.

You can check that you have located the correct star by using
the Object Selection Tool, described above. Click on the arrow
icon at the top of the icon/location box, or press the F3 key.
The cursor will now be an arrow. Click on the mouse with the
arrow adjacent to the chosen star and its name will appear on
the screen. To remove this name, click the mouse with the cur-
sor on blank sky. Return to the Grabber Tool by clicking the
mouse on the hand icon at the top of the icon/location box, or
press the F4 key.

To find the next set of stars and constellations, you will have
to change your viewpoint, or the direction in which you are
facing in the sky. To do this, place the cursor hand of the
Grabber Tool somewhere on the Big Dipper, then press the left
mouse button. KEEP HOLDING THIS BUTTON DOWN and
use the mouse to move the hand slowly toward the right across
the screen, as explained earlier. The hand drags the sky with it
across the screen. Use this action to place the Big Dipper on the
right-hand side of the screen, about halfway down from the
top of the screen. Make sure that the Big Dipper is close to the
right edge of the screen, with all of its stars visible (move the
sky back to the left again a little if necessary).

Now find the star Arcturus. To do this, look at the handle of
the Big Dipper. Notice that the handle is curved and forms an
arc in the sky. Imagine this arc extended through the sky in the
direction away from the bowl (toward the left and somewhat
down on your screen). Then you should find that it passes
more or less through a bright star near the center of the screen.
This star is Arcturus. (A good way to remember how to find
this star is, ““Follow the arc to Arcturus.”)

Use the Object Selection Tool to confirm your identification of
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10.

Arcturus by clicking on the arrow button in the icon/location
box, and then clicking the mouse with the arrow icon placed
close to the chosen star. The name of the star will be displayed.
Click the mouse again with the icon on blank sky to remove
the name, then return to the Grabber Tool.

Arcturus is the brightest star in the constellation Bootes, the
hunter. (The two 0’s in Bootes are pronounced separately: “Bo-
otes”; to show this, it is often spelled Bodétes.) If you look
toward the upper right from Arcturus on your screen, you
should see a pentagon of five stars with a fainter sixth one just
above them. If you ignore the sixth one, then Arcturus plus the
other five form a kite-shape or an ice-cream cone in the sky. In
the real sky, the whole constellation of Bootes is quite large,
and the kite or ice-cream cone forms the most easily seen part
of it. The orientation of Bootes in the real sky may be different
than on your screen, depending on the time of year and time of
night. However, the shape will always be the same, and the
brightest star in this constellation can always be found by start-
ing from the Big Dipper and “following the arc to Arcturus.”

In the real sky, Arcturus has a yellowish or even slightly orange
tint because it is slightly cooler than the Sun.

Bootes is hunting the Great Bear—as the sky turns counter-
clockwise around the North Star, Bootes follows the Great
Bear around the sky. If you look below the handle of the Big
Dipper on your screen, you should see Bootes’ hunting dogs,
two relatively faint stars that form the constellation Canes
Venatici (Latin for “dogs of the hunter”). These two dogs nip
at the heels of the Great Bear as it circles the North Star, try-
ing to get away from Bootes.

Another interesting constellation to find before leaving Bootes
is Corona Borealis (the Northern Crown). This is the semicir-
cular arc of stars next to Bootes’ shoulder (to the left of the top
of the Kite or ice-cream cone on your screen).

Click the constellation lines on to see the full extent of the con-
stellation Bootes and the smaller constellation Canes Venatici,
then click them off again.

To find the next set of stars, you need to adjust the screen



11.

12.

again. The Big Dipper should still be where you set it in step
7, on the right-hand side of the screen about halfway down
from the top. The adjustment you need to make is to move the
Big Dipper upward, to the upper-right-hand corner of the
screen. Do so by following the instructions in step 7. Place the
cursor hand on the Big Dipper, hold the left mouse button
down, and drag the sky upward. Place the Big Dipper close to
the corner, but make sure that all seven stars are still visible.

The next star to find is Spica. To do so, start with the handle
of the Big Dipper and ““follow the arc to Arcturus.” Then con-
tinue this arc to Spica, a relatively bright star. You should find
Spica in the bottom left portion of your screen, roughly the
same distance past Arcturus that Arcturus is from the handle
of the Big Dipper. Spica is considerably hotter than the Sun
and has a whitish or even slightly bluish tint when you look at
it in the sky.

Spica is the brightest star in the constellation Virgo, the Virgin.
You can check that you have found Virgo correctly by clicking
the constellations on and looking for the name *““Virgo™; then
click them off again. You can also check that you have found
the star Spica correctly, using the Object Selection Tool as
described above.

Now find the star Regulus. To do this, go back to the Big
Dipper, and use the pointer stars in reverse—instead of point-
ing upward to find the North Star, point downward from
them a distance somewhat greater than the total length of the
Big Dipper, or about nine times the spacing of the pointer
stars. You should find two moderately bright stars. The one
that is farther from the Big Dipper (lower on your screen) and
somewhat brighter than the other is the star Regulus, the
brightest star in the constellation Leo, the Lion. Click the con-
stellations on and off again to check that you have found Leo,
and use the Object Location Tool to be certain that you have
located Regulus.

To find the star pattern making up the constellation Leo, first
look for a line of stars running from Regulus through the other
bright star and forming the shape of a backward question mark.
This forms the head and front legs of the lion. Then look for a
triangle of stars that forms the hind end and tail of the lion.
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(Clicking the constellation lines on and off will help you pick
out these patterns.) In the sky, the backward question mark and
the triangle form the most easily seen parts of the constellation.

Like Spica, Regulus is much hotter than the Sun and has a
whitish or even slightly bluish tint when you look at it in the sky.

You have now explored the northern sky, identifying several
constellations and bright stars while becoming familiar with
the Starry Night™ program and many of its features. If the
opportunity arises, you should attempt to explore the real
sky and identify these features from your home location. You
can use Starry Night™ to show which stars and constella-
tions are visible from your own location at any time by sim-
ply placing yourself at your home location and using the
Now button in the date/time box, or entering a suitable time
such as 10:00 tonight.

If you want to save this configuration for future reference, you
can use the “Save as” command in the File menu, giving the
configuration a hame and saving it in a convenient location.
You can then return to it merely by opening this file.



